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Before you start… 

The hands-on exercise of SAP Analytics Cloud is going to take about 2 hours. In this hands-on 

demonstration, we are using a vehicular accident scenario that will help trace common occurrences 

of roadside accidents (what time, what place, what type of car, etc). 

 

This follows the United Nations Sustainable Development Goals 11: Make 

cities and human settlements inclusive, safe, resilient and sustainable  

Find out more about UN SDG 11: https://www.un.org/sustainabledevelopment/cities/ 

 

Cities are hubs for ideas, commerce, culture, science, productivity, social development and 

much more. At their best, cities have enabled people to advance socially and economically. 

With the number of people living within cities projected to rise to 5 billion people by 2030, it’s 

important that efficient urban planning and management practices are in place to deal with 

the challenges brought by urbanization. 

Many challenges exist to maintaining cities in a way that continues to create jobs and 

prosperity without straining land and resources. Common urban challenges include 

congestion, lack of funds to provide basic services, a shortage of adequate housing, 

declining infrastructure and rising air pollution within cities. 

Rapid urbanization challenges, such as the safe removal and management of solid waste 

within cities, can be overcome in ways that allow them to continue to thrive and grow, while 

improving resource use and reducing pollution and poverty. One such example is an 

increase in municipal waste collection. There needs to be a future in which cities provide 

opportunities for all, with access to basic services, energy, housing, transportation and more. 

The aim of the dataset is to come up with protocols that factor in passenger safety despite a steady 

growing urban population in the UK.  

 

https://sustainabledevelopment.un.org/sdg11
https://www.un.org/sustainabledevelopment/cities/
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If you have the Username and Password already, please use them to log into SAP Analytics Cloud. 
 
If not, you can get them by attending the enablement session, data analytics training on SAP Analytics 
Cloud, provided by the ASEAN Foundation and SAP for students and lecturers across the 10 ASEAN 
countries. A series of sessions are annually conducted for FREE from February to March (schedule 
may change). All participants attending the sessions will be given access to SAP Analytics Cloud. For 
inquiries on the enablement session, please contact Mr. Ilan Asqolani, Project Manager for the 
ASEAN Foundation-SAP Joint Initiatives through his email: ilan.asqolani@aseanfoundation.org. 
 
Alternatively, you can get FREE access to SAP Analytics Cloud by participating in the ASEAN Data 
Science Explorers competition. You can sign up for the competition at www.aseandse.org. Call for 
applications is annually open from February to March (timeline might change). The access is valid 
until end of the year. 
 
Also, you can obtain a 90-day free trial access to SAP Analytics Cloud via the following link: 
https://www.sap.com/cmp/td/sap-analytics-cloud-free-trial.html    

https://aseandse.ap11.hcs.cloud.sap/hub/index.html  
 
Go to the link:  

 

Please use the Google 

Chrome browser to open 

this URL. 

 

If you already have the 

Username and Password, 

please use them to log in.  

 

 

 

 

 

 

mailto:ilan.asqolani@aseanfoundation.org
http://www.aseandse.org/
https://www.sap.com/cmp/td/sap-analytics-cloud-free-trial.html
https://aseandse.ap11.hcs.cloud.sap/hub/index.html
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Welcome to your 

homepage! 

On the top left of the 

page, click on the menu 

bar. 

 

Click ‘BROWSE’ 
Click ‘FILES’  

 

 

Click on ‘PUBLIC’ 

 

 

In case you could not find 
the specify folder, please 
use the search engine.  

 

Click on ‘ADSE 2021 
TRAINING MATERIAL’ 

 

Click on ‘SAVE YOUR 
WORK HERE’  
 
Each user has a working 
area that contains the 
solutions for all the 
exercises in this workshop. 
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Click the folder of your own 
country. 
 
Please save your stories 
into the folder of your 
country of origin with your 
own name. 
 
EXAMPLE: 
Data 
Import_ANNABELCHENG 
 
PATH TO SAVE FILES: 

Browse Files – Public – 

ADSE 2021 Training 

Materials – You’re your 

Work Here – [Country] – 

Data Import_Your Name 

 

 

 

Exercise  

 

Today for our ASEAN Data Science Explorers Enablement Session in Data Analytics Training - SAP 
Analytics Cloud, we will be analysing a dataset that revolves around an accident that happened in the 
UK, in particular, vehicular accidents. This follows the United Nations Sustainable Development Goals 
11: Make cities and human settlements inclusive, safe, resilient and sustainable. 
 

 

Open SAC link on 
Google Chrome. 
 
Key in the 
credentials 
assigned to you. 
 
 

 

https://aseandse.ap11.hcs.cloud.sap/hub/index.html
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You have arrived at 

your homepage! 

 

On the top left of the 

page, 

 

Click ‘BROWSE’ 

Click ‘FILES’ 

Click ‘PUBLIC’ 

Click ‘ADSE 2021 

Training Material’  

 

This is where all files 

for the enablement 

session will be kept. 

Your saved files 

should exist within 

this folder as well.  

 

 

 

 

 

 

 

 

 

 

https://asean2019.us1.sapanalytics.cloud/sap/fpa/ui/tenants/031#view_id=contentLib;resourceId=PUBLIC;resourceType=FOLDER
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Public > ADSE 2021 

Training Material > 

Excel Source File  

 

Open file ‘Excel 

Source File’ 

Click on ‘UK Accident 

Information (Data 

Import).xlsx  

 

The file should be 

downloaded into your 

desktop.  

 

 

 

 

 

 

Open the file you 
have downloaded. 
*do not log out of 
your SAC account, 
we will be coming 
back to it later 

 

EXCEL  SHEET:  UK  ACCIDENT INFORMATION (DATA IMPORT ).XLSX  

 

Open up the Excel sheet 

titled: UK accident 

information (data 

import).xlsx  

 

We were able to retrieve 

the datasets from the 

internet dataset portals. It 

is not 100% accurate but it 

is close to life. It has been 

tailor-made and 

customized to be able to 

fit the purpose of the 

exercises that we will be 

using and working on SAP 

Analytics Cloud (SAC).  

So, let me spend a few 

minutes to go over the 

contents of this data set. 

 

https://drive.google.com/file/d/1RRjAZ17UGpkDqhWxYHUifl-SbEvmJnKC/view?usp=sharing


 8 

First of all, we have the 

accident ID or identifiers – 

these are basically the 

report numbers. We have 

date here and if you 

noticed, we have explicitly 

left some of these date 

with an ‘X’ which we will 

be using in the exercise of 

cleaning the data. 

 
 

Next, we also have some 

geographical information – 

country, city descriptions, 

complemented with 

longitude and latitude 

points which will be using 

for geospatial analysis. 

 

 

We also have more 

information about the 

accident. For example,  

• What time of the 
day did the 
accident occur?  

• What was the road 
conditions?  

• Was it near a stop 
sign? A traffic 
lights? Or a traffic 
enforcer?  

• Where did the 
accident occur? 
Was it in an urban 
or rural setting?  
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There is also some 

information about the 

vehicle. For example, 

• Was the driver 
male or female? 

• What is the age 
range of a driver? 

• What type of car 
he or she was 
driving? 

• What is a 
propulsion of the 
car?  

• Was it a hybrid 
electric car or a 
petrol car? 

 

 

To the right, we have 

some numerical 

measures. Each row 

represents one number of 

accident but we also are 

able to see if the number 

of casualties and vehicles 

involved per accident and 

the accidental costs 

incurred, perhaps due to 

damages, medical or 

hospitalisation fees.  

 
 

WELCOME TO SAP  ANALYTICS CLOUD!   
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Now that we understand 

the content of this data 

set, the first step is to 

upload the data set into 

SAP Analytics Cloud.  

 

Once we access it through 

a browser, what the first 

want to do is opened is 

upper left-hand menu and 

be able to see the ‘create’ 

tab which is what we're 

going to be using bulk 

during our exercises. This 

‘create’ tab is to create a 

story which is the 

reporting visualization 

layer which will be playing 

with later on but right now 

let's concentrate on 

creating a model. 

 

 

 
 

 

MODELLING  

 
Model is the basic building block of SAP Analytics Cloud which is the data that is being fed to the 

visualizations and charts that we would be using later on. 

 

Click on “Import a file from 

your computer” 

Select “source file” 

Click on “UK accident 

information (data 

import).xlsx” 

Check “use first row as 

column headers” 

Click ‘Import’. 

What is happening now is 

that we are uploading data 
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into SAP Analytics Cloud so 

that we don't have to work on 

Excel anymore. 

In a few seconds, you will 

receive a message that says 

that your data has been 

successfully uploaded. You 

should be able to see the 

table similarly to how we 

would do in an Excel sheet.  

 

If you remember what you've 

seen a while ago, this sheet 

is similar to the excel sheet 

opened previously with the 

accident ID, date, location 

etcetera.  

 

Another way to view this 

information in a much cleaner 

detail is by switching layout 

and in the form of tiles. Click 

on this in the ‘layout’ option. 
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If you click on of these areas, 

on the right, you will be able 

to see the data distribution to 

know how many of our data 

points come from UK03 ID 

etc. We are able take a look 

at a high level of how much 

data we have for each of 

these areas that may or may 

not have an impact in our 

analysis later on. 

 

One thing to notice are these 

green bars at the bottom of 

each of the tiles. These bars 

represent the health and 

accuracy of that data. If the 

bars are completely green, it 

is a good thing and means 

that we have complete 

information without any 

errors in the data identified 

by SAP Analytics Cloud. 

 

Alternatively, if you do notice 

and some hints of red, it 

could mean that there are 

some pending errors that 

needs to be corrected. 
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Now, if you remember a 

while ago, we left some 

values under the ‘date 

dimension with an ‘X’ and 

SAC is able to pick this up 

automatically and it is 

registered as invalid date 

format in the software.  

 

 

 

  

Instead of going back to 

Excel and correcting the 

data, we have the option to 

just transform it and fix it 

within SAC. 

 

Switch the layout from tiles to 

sheet display. 

In the drop bar, click the 

transform key.  

 

As we know these were 

probably all under the 

January 2017 date range so 
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what we can do is simply just 

replace these values of ‘X’.  

 

Click ‘Replace value with…’ 

 

At the top, type “2017.Jan” 

following the format of the 

date range on the other rows.   

Click ‘Enter’  

 

It will automatically replace 

all ‘X’ with your new value 

input “2017.Jan”.  

 

Now, on the side panel, you 

will see that there is no data 

quality issues detected. The 

health bar is restored to a full 

green. 

  

 

 

 

The second thing we are to 

do is to establish hierarchy. 

An example of a hierarchy is 

having a country and being 

able to drill down by cities. 

For example, UK drilling 

down to cities like 

Birmingham, Manchester, 

Westminster etcetera  
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We can create hierarchies by 

clicking on ‘actions: level-

based hierarchy’ button at 

the top 

 

Give the hierarchy a name. 

In this case, we name it ‘City’ 

 

We work backwards by 

taking for the lowest level of 

this hierarchy, which in this 

case would be the location 

description or the city, and 

then work to the top which is 

‘country’. 

 

Click ‘Location Description’ 

Click ‘Country’  

Click ‘ok’  

Confirm modelling changes 
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We want to utilize the 

longitude and latitude data 

points  

Under Actions, click on ‘Geo-

enrich by:’ button 

Two options to geo-enrich by 

coordinates or area name.  

 

To be able to be more 

specific with the data of 

points, it is highly 

recommended to use 

longitude and latitude points 

which is what we would be 

using today.  

 

 

Click ‘Coordinates’.  

A pop-up should occur. 

Map the missing fields with 

the ones that are already in.  

 

Location ID tab: click 

‘location ID’ 

Location description: click 

location  

description 

 

Latitude and longitude should 

be automatically picked up 

by the system as well  

 

Click ‘Create’ 
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Once that is done, the 

geopoint should be 

automatically be created 

here on the right.  

 

Once we have created these 

geopoints, we have no need 

for longitude and latitude 

points for analysis anymore. 

 

Select the columns: 

Longitude and Latitude 

Right click: Delete these 

columns. 

 

* Important: please do NOT 

delete the location ID column 

(only longitude and latitude)  

 

 

 

Last but not least, scroll to 

the right make sure that 

these tabs ‘Number of 

accidents, number of 

casualties and number of 

vehicles’ are picked up as 

measures (not generic 

dimension). 

 

Do it individually for each 

column (numbers of xxx). 
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You can take one more look 

at your data sets by 

switching the layout to tiles to 

confirm that everything is in 

the green and everything is 

ready to be used for analysis.  

 

 

Click “Create Model”  

A pop-up should occur as the 

system will run one last 

validity check.  

Click ‘Create’ 

 

 

Save your model - We 

navigate to a specific folder. 

Click Public >  

 

ADSE 2021 Training Material 

>  

 

[COUNTRY] 

 

Name it “DATA 

MODEL_YOUR NAME” >  

 

Click ‘OK’ 

 

PATH TO SAVE FILES: 

Browse Files – Public – 

ADSE Enablement 
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Session 2021 – [Country] 

– Data Import_Name 

 

 

 

 
Done! Model Created Successfully! 
 
In this exercise, we have learnt to: 

• Import data sets 

• Evaluate the data set 

• Fix some errors  

• Create Hierarchy  

• Fix Geopoints  

• Transform columns from dimensions to measurements  
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Now that we have created the model, we will proceed to create our visualization.  

 
 
Click ‘Menu’ > Create > Story  

 

A story is what we call a form 

of reports and visualization on 

SAP Analytics Cloud. 

 

We have several options to 

start from using some of 

templates here at the bottom 

right:  

 

Add a canvas page – for fixed 

reports 

Add a responsive page – great 

for mobile devices with 

automatic resizing (Most 

recommended template to 

start from if you are creating it 

from scratch) 

Add a grid page 
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For now, begin with Smart 

Discovery so that we don't 

start from the very beginning. 

 

Search for the model that we 

just created  

My files > Public > ADSE 2021 

Training Material > 

[COUNTRY] > Name you 

saved as earlier* 

 

PATH TO SAVE FILES: 

Browse Files – Public – ADSE 

Enablement Session 2021 – 

[Country] – Data Import_Name 

 

Click ‘OK’  

 

Smart Discovery uses 

machine-learning to generate 

insights about our dataset 

without having to go through 

the nitty-gritty ourselves. 

 

On the right of the page, a 

‘Smart Discovery’ dropdown 

box asks us which measure 

we want to know more about 

and conduct the analysis on. 

 

Now, let's ask the SAP 

Analytics Cloud to figure out 

what are the probable 

influencers of number of 

casualties in these accidents.  
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Hence, on the Target, click on 

‘Select a dimension or a 

measure’. 

Then select on ‘Number of 

Casualties’. 

 

 

 

 

 

 

For the Entity, we can select 

up to ten dimensions. Hence, 

let select (i) Area Type; (ii) 

Driver Age; (iii) ID; (iv) 

Junction Control; (v) Junction 

Description; (vi) Location 

Description; (vii) Road 

Condition; (viii) Sex of Driver; 

() Time of Day; (x) Vehicle 

Propulsion.  

 

 

 

Click ‘RUN’ and it will give us 

back some results on what are 

the things that impact the 

number of casualties per 

accident. 
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In just a few seconds, you 

were able to generate all of 

these charts automatically so 

the results of a Smart 

Discovery make for a really 

good starting point when it 

comes to creating our charts. 

 

 

Number of Casualties 

At the top left, we have a total 

number of the casualties 

based on our dataset. It shows 

that we have a minimum of 

one person suffering in an 

accident, with a maximum of 

11 people involved in one 

accident. 

Below that, we also could see 

the timeframe of the 

casualties. 
 

 

On the top of the page, click 

on the tab ‘KEY 

INFLUENCERS’.  We want to 

get a deeper look on the key 

influences that affect the 

number of casualties. In blue, 

SAP Analytics Cloud 

automatically highlights the top 

three that is the most 

impactful. 

 

Number of vehicles involved: 

This goes without saying as 

the more cars involved in an 
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accident, the more probable it 

is for more people to suffer a 

casualty. 

 

Time of day plays a huge part 

in the potential of having 

casualties as well. 

Driving out in the early 

morning, between midnight to 

early 6 a.m., has higher 

chances of suffering from 

casualties. This could be due 

to be overconfidence of driving 

on the road since there are 

less people on the road, 

driving late coming from 

parties, exhausted driver or 

driving under the influence and 

hence, more prone to being 

less alert and cause accidents. 

 

 

 

 

 

For all of the influencers, we 

are able to get more 

information about each item if 

we hover our cursor over the 

bar chart, and click on the pop 

out tab with text ‘how does it 

influence Number of 

Casualties’ – a side panel will 

pop up on the right side of the 

page with more details. 
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For example, click on ‘Area 

Type’ > ‘how does it influence 

a number of casualties’  

And we see that on average, 

small towns seem to have just 

a tad bit more average number 

of casualties. Assumptions 

made here are that it could be 

because in a less urbanized 

environment, there would be 

less traffic lights and people 

might not adhere to traffic rules 

hence resulting in slightly 

higher number of accidents.  

 

Next, let’s move to the next 

part of the smart discovery is 

to run a simulation 

 

tab ‘SIMULATION’ 

 

A simulation ties together all 

the different influencers we 

were able to pull together. We 

can see how if we were to 

change particular aspects of 

these notes, how would it, in 

turn, impact the expected 

number of casualties. 

 

For example, if we forecast or 

simulate an accident that 

involves around seven 

vehicles, we can expect a 7% 

increase in the number of 

casualties. We can play 

around with these different 

figures to see which and how 

influences affect the number of 

casualties. 
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Smart discovery gave us a 

very nice jump start to create 

a dashboard.  

Click on the (+) Tab, Click on 

Responsive.  

Now, we are able to create 

our own analytical 

visualisations with the help of 

the query.  

 

Let’s rename the story tab 

‘Page 1’. Point the cursor on 

Page 1.  

 

Click on ‘Rename’ 

‘Page 1’ to ‘Analysis’ 

Click ‘Rename’  

 

 

At the top left of the page, 

shift from story to the data 

view and it will bring us to the 

explorer mode where we are 

able to create ad-hoc tables 

and charts by selecting a 

combination of different 

parameters. 
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For example, click on number 

of casualties and this chart at 

this blank space at the 

bottom will automatically give 

a total number of casualties. 

 

 

 

 

Take a look at how driver’s 

age plays a part. It creates 

an automatic bar chart. 

 

We can click on Bar/Column 

(auto suggested) to change 

the type of visualization you 

see many options.  

 
 

 

Click on ‘Charts’ 

> ‘More’ 

> ‘Pie Chart’  

To make it cleaner, we can 

sort from ‘highest to lowest’ 

 

We are able to see at a glance 

that the number of casualties 

for drivers above age 56 is 

higher than the rest. It could 

play a role that elderly is more 

susceptible to causing 

accidents on the road and may 

mean that we need to provide 

additional training/retraining for 

people older than 65. 
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Once we have the chart, we 

click on the ‘file’ icon 

‘Copy to Analysis’ the page 

we have just created 

You will receive a notification 

that visualization successfully 

copied. 

 

Now we can begin including 

these visualizations that we 

will use later on. 
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Feel free to resize the charts 

by dragging the corners and 

you’ll see a grid interface.  

 

 

 

Switch back to Data View. 

 

You can create more graphs 

by: 

Deselecting ‘driver age’ 

 

Select ‘Junction Detail’ tab 
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Now, let’s view a bar chart 

instead. 

  

Sort it by ‘Highest to Lowest’. 

 

 

 

 

We now see that most of the 

accidents happen when they 

are not at the junction. 

 

Let’s copy and paste this 

chart into our Analysis Tab. 
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Switch back to Data View, 

you can bring more 

dimension from your dataset. 

 

Let’s choose the Region. 
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Create another graph on the 

region and copy it to Analysis 

tab.  

 

 

 

In this part of the exercise, 

the instructor will come up 

with questions to help you 

play around with data 

explorer and create more 

queries to use in your 

analysis.  

  

 

 

In this exercise, we are 

introducing filters through input 

controls and calculations to 

enhance our analysis.  

 

 

 

First, let’s make space for that 

by customizing the lanes or 

these white spaces. 

 

Click on the Ellipsis button > + 

Add Lane > Add Lane to the 

Left 
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We now have the small space 

where we will put our filters on. 

You can resize by dragging the 

columns so that it is not 

skewed and you can resize the 

rest of the columns as well. 
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First, create an input control, 

under the ‘insert’ category on 

the toolbar  

 

Click on ‘Page Filter’ > Select 

a dimension ‘Dimensions’ > 

‘Time of Day’ 

 

 

 

Select ‘ALL MEMBERS’ (all 

boxes will be checked) > ‘OK’ 

 

Drag the box it to the left and 

you can expand it so you can 

read the text 

Add another dimension 
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Click on ‘Page Filter’ > Select 

a dimension ‘Dimensions’ > 

‘Vehicle Propulsion’ 

 

Select ‘ALL MEMBERS’ (all 

boxes will be checked) > ‘OK’ 

Drag it to expand it 

 

Now, we can play around with 

boxes 

‘Time of Day’ Box – Select 

only ‘early morning’ and we 

can see how is that is broken 

down 

 

Next, click on the chart 

‘Number of Casualties per 

Region for Actual’ 

Expand the ‘designer mode’ in 

the builder mode 
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The builder mode allows you 

to have a detailed view of what 

the chart is comprised of.  

 

We can see the chart type; we 

can see the measuring 

dimensions in which these are 

part of and we can also 

change the colour add some 

filters to these graphs as 

necessary. 
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To find out the average 

number of casualties… 

 

Look under ‘measure’ to find a 

(+) plus button click ‘Add 

Measure’  

 

Click on ‘Create Calculation’ 

 

 

As the name suggests, 

calculations mean that it is 

able to run formulas on 

measures that we already 

have and make them more 

specialized or specific  

 

Type: AGGREGATION  

We have different options for 

operations here, for example, 

we are able to SUM, MIN, 

MAX etc. 

 

Operations: Click ‘AVERAGE’ 

Measure: Number of 

Casualties 

Aggregation Dimensions: ID 
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We want to run a calculation 

on how many average 

numbers of casualties we have 

across all the different ID 

reports. 

We name this: Average 

number of casualties 

Click ‘OK’  

And we can deselect the 

original ‘measures: number of 

casualties’ button, you should 

only see ‘average # of 

casualties’ under your 

MEASURES tab 

 

So, we now have a breakdown 

geographically of the average 

number of casualties per 

region in the UK 

 

 

 

 

We also want to introduce the 

concept of measure input 
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controls so these are filters on 

the measures. 

 

Click on ‘ADD MEASURE’ > 

and at the bottom of all these 

different measures, select ‘+ 

Create Measure Input Control’ 

> ‘All Account Members’ and 

this should check all boxes > 

Click ‘OK’ 

 

You should see a new bar 

should pop up on your screen 

that says ‘New measure input 

control’ 

 

Drag and drop it to our 

measure input column and 

expand it for visibility 
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In the ‘Average number of 

casualties, number of 

accidents per region for actual’ 

chart 

 

Deselect the ‘average number 

of casualties’ so you only have 

the ‘New Measure Input 

Control’ selected (on the right 

panel) 
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Click on this input control (left 

column) and change the 

measure that changing the 

‘Average number of casualties 

broken down my location 

description’ chart so you can 

change to see the number of 

casualties, number of vehicles, 

accidental costs by location 

etcetera 

 

That is the basic on creating 

these filters, input controls and 

also creating calculations. 

 

Save your work!  

 

 
 

 

Now in this exercise we’re going to take a little different visualization options that we have, playing 
around, changing some of the design elements and also creating Geospatial map analysis.  

 
First, let’s select all the 

Time of Day again to 

make sure of the factors in 

the analysis.  

 

Then let’s open up the 

Designer mode. What you 

want to do is introducing a 

new chart. We do that by 

clicking on the insert 
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button, then click on insert 

a new chart. 

 

 

 
 

Let’s drag it into the empty 

space below the bar chart. 

And I want to introduce a 

Time Series analysis.   

 

In this Time Series 

analysis, I want to run the 

number of Casualties. 

  

According to the time, 

which is the date, we now 

have this Time Series 

chart that shows the trend 

of how the casualties have 

increased or decreased 

throughout time. 
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Now we can add another 

layer to this by taking a 

look at Area Type. So, we 

then see how casualties 

are different, how many 

happened in urban, small 

towns and rural areas.  

 

 

 

 

 

 

 

You can add further layer 

of design to the charts by 

changing the colour. 

There are templates for 

you to choose from. You 

can also create your own 

palette, if you’re aiming for 

a specific colour skim for 

your presentation. 

 

Now you can play around 

different colour elements 

and try to have a uniform 

look. 
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You can change all the 

different visualizations 

from the Designer Mode 

as well.  

 

For example, for the bar 

chart you have the option 

of turning it to vertical 

orientation. 

 

And you can play around 

with all these different 

tools to choose the correct 

visualization option to 

change the colour as well 

change the chart title to fit 

the content of your chart 

elements. 

 

So next let’s run a Geo 

analysis and we do that by 

creating a new page.  

 

Click the plus button, then 

click on responsive. Then 

rename the page to be 

“Geospatial” 
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Click on the (+) Group 

under the Insert Tab, and 

then select Geo Map.  

 

Now we add a Geo map to 

this visualization. You can 

expand it a bit. 

 

And we choose a new 

model, an existing model 

so you may have to 

search first.  

 

We do it by selecting the 

other model and you can 

simply type 

“Geoenriched”. 
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Leave it as a bubble layer.  

 

For Location Dimension, 

click on Location. Which 

will pop out the location 

point on the map that we 

have during the data 

embark stage.  

 

For the Bubble Colour, we 

can do number of 

accidents. And for the 

Bubble Size we can do 

Number of Casualties as 

an example. We can then 

adjust the scale as 

necessary.  

 

So, we can see the bigger 

circles correspond the 

higher number of 

casualties, while the 

colour represents the 

number of accidents.  

 

So right off the bat we’re 

able to observe that there 

are some cities: Leeds, 

Manchester and 

Birmingham which have 

high number of accidents 

and casualties.  

 

You can also adjust the 

bubble size or bubble 

colour.  
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Then click ok, go back to 

the map. We can change 

the type of map that we 

are looking at as well to fit 

the styling or the type of 

view that we’re looking at.  

 

We have several options; 

we have Street Map as 

well. You can zoom in as 

necessary.    
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What is the best browser to use for SAP Analytics Cloud?  

Highly suggest Google Chrome, especially incognito mode if you run into any issues.  

Where to find data sources?  

World Economic Forum, Government sites, The World Bank, Your academic platforms or 

https://datasetsearch.research.google.com/ to name a few 

Where do I find more resources on SAP Analytics Cloud? 

Here’s our blog with a variety of topics surrounding the tool: https://www.sapanalytics.cloud/blog/ 

YouTube: https://www.youtube.com/user/SAPBusinessObjects 

https://www.youtube.com/watch?v=wCLmDUzTd4Q&list=PLufF7pZxICBisuuNMmNSrhmWkGGiyT3LU 

We are launching a course on https://open.sap.com/ in 2020! Stay tuned! 

More about ADSE? 

Here’s our website: https://aseandse.org/  
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